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Visitor Management System Module Settings
and Operation Guide. Introduction

On the page:

® Purpose of the document
® General information about the Visitor
Management System module

Purpose of the document

This Visitor Management System Module Settings and Operation Guide is a reference manual designed for Visitor
Management System module configuration technicians and operators. This module is part of an access control system
(ACS) built on the ACFA Intellect Software System.

This Guide presents the following materials:
1. general information about the Visitor Management System module;

2. Visitor Management System module settings;
3. working with the Visitor Management System module

General information about the Visitor Management System module

The Visitor Management System software module is a component of an ACS built on the ACFA Intellect Software System
and supports the following actions:

1. observe employees' and visitors' access to objects using automated access control systems and their movement
about the objects in accordance with granted access levels;

2. configure user rights to edit and view departments and employees;

3. create and configure access levels for individual employees and entire departments;

4. create templates and stamps for electronic security passes for employees and visitors to protected objects.

Licensing policy for Visitor Management
System

If you acquire 1 license for this module, it will allow you to use any number of Visitor Management System objects on
any number of computers (Servers/RAWs and Clients). The same license also opens Access Manager reports object
under Web Report System object so that you could use corresponding reports after Intellect Web Report System installati
on (for more information, see the Intellect Web Report System. User Guide) . In addition, the license allows the use of all
integrated control readers (see the Control Readers Settings Guide).

Starting and stopping the Visitor
Management System software module
Starting the Visitor Management System software module

To start the Visitor Management System software module, do the following:


https://doc.axxonsoft.com/confluence/display/rpt34/Intellect+Web+Report+System.++User+Guide
https://doc.axxonsoft.com/confluence/display/acfaen/Control+Readers+Settings+Guide

1. Create a Visitor Management System object based on the Screen object on the Interfaces tab of the System
Settings dialog.

EI---ﬁ Zkpad 1[1]
E-sit-:ur Management System 1 [1] }

2. Go to the Visitor Management System object's settings pane.

;-T.,]\-fisitor Management System 1 || = [ All deparntrnents
PR - ¥ Department 1
: [ Disable
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[w]Full access
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3. Specify the position parameters for the Visitor Management System module's window:
1. Check the Fix position box if you need to keep the module's window in a specific place on the desktop.

2. To configure the position of the Visitor Management System software module's window, specify the
coordinates of the window's upper left corner in the X and Y fields and its width and height in the W and H
fields.

4. Click the Apply button.

Performing these actions will result in the Visitor Management System module's window being displayed on the screen.

Note:

Subsequently, the Visitor Management System software module will be started automatically after the ACFA
Intellect Software System is started.
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Stopping the Visitor Management System software module

To stop the Visitor Management System software module, do one of the following three actions:

1. Click the E button on the ACFA Intellect Software System's main control panel and select the Close all menu
item.

o R ) 5

¥ Close all

Screen 1

2. Click the EI button in the upper right corner of the Visitor Management System software module's window.

Note:

After using this method to stop the module, you must restart the ACFA Intellect Software System to start
the Visitor Management System software module again.

3. Go to the File menu and select Exit.

+4 Visitor Management System - Departments

:| File | Correction  Wiew  Service Help

Note:

After using this method to stop the module, you must restart the ACFA Intellect Software System to start the Visi
tor Management System software module again.



Visitor Management System software
module settings

Basic settings of the Visitor Management System
software module

The Visitor Management System software module's basic settings are configured as follows:
1. Go to the Visitor Management System object's settings pane.

.—il\-"isitor h anagement System 1
Display

| Disable

= I:| All departments
“- [ Department 1

[ JFull access

Mo

2. Specify the department access parameters for Visitor Management System operators:
1. Select the access level for viewing departments from the View dropdown list (1).

Access levels for viewing departments:

Access level Description
All All department properties are viewable
Some Information about department access levels is unavailable for viewing
No Departments are not viewable

2. Select the access level for editing departments from the Edit dropdown list (2).
Access levels for editing departments:

Access level Description
All All department properties are editable
Some Editing department access levels is unavailable
No No department properties are editable

3. Check the Add box to grant access to add new departments (3).
4. Check the Delete box to grant access to delete departments (4).



3.

4.
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11.

12.

5. Set the Add new departments checkbox to add new created departments to the Visitor Management
System module automatically (5).
Specify the user access parameters for Visitor Management System operators:
1. Select the access level for editing users from the Edit dropdown list (1).

Al b

Access levels for editing users :

Access level Description
All All user properties are editable
Some Editing user access levels is unavailable
No No user properties are editable

2. Check the Add box to grant access to add new users (2).

3. Check the Delete box to grant access to delete users (3).
In the list of departments, check each department that should be available to a Visitor Management System
module operator.

=[] &l departments
Departrnent Clients
Department Employess
Departrnent T raffic

. In the Access levels field, check each access level that should be available to a Visitor Management System

module operator.
Aooess levels [ Create uzers with antipassback

[wldcoess Level 1
[wltcoess Level 2
[w]Full access
[w]Mi

. Check the Create users with antipassback box if users should be created with a feature activated that monitors

double-entry.

. To enable the ability to view and edit access parameters, check the View access parameters and Edit access

parameters boxes, respectively (1).

3

v fiew access parameters
Edit access parameter
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. Check the Discharge access card box to allow the Visitor Management System module operator to close (delete)

users' security passes (2). Discharging of the user access cards is described in Canceling user cards section.

. Check the Print access card box to all the Visitor Management System module operator to print security passes

from the module's window using the system's default printer (3).

Note:

The utility ARPEdit.exe, which is included with the ACFA Intellect Software System, is used to edit the
printing format.

Check the Export data and Import data boxes to allow the Visitor Management System module operator to
import and export data using the integrated ACFA Intellect Software System utilities and the corresponding
software module (4).

Use the spinbox buttons to specify the number of additional access levels available to the Visitor Management
System module operator (5).

Check the Set expiry date box if the period of the additional access level should be added and taken into account ('

).



13. From the Camera dropdown list, select the video camera that will be used to capture a picture for the security
pass (1).

I Nseriitie:
|

14. If the selected video camera is connected through a video gateway, select the gateway from the corresponding
dropdown list (2).

15. Select the ACS reader that will be used to read codes from user cards from the Reader dropdown list (3).

16. Check the Confirm card entered by operator box if user card assignments must be confirmed (4).

17. If events occurring in the Visitor Management System software module should be displayed on all screens on which
a Visitor Management System object has been created, check the Send to all screens box (5).

p

For example:

If users add access cards to the system using the Visitor Management System module and an access
control reader, and the reader is configured such that operator confirmation of entry is required (e.g. the C
onfirm card entered by operator box is checked), then when the Send to all screens box is checked a
window prompting to add will appear on all screens where the Visitor Management System module is
available.

\

18. Click the Apply button.

This completes the process of configuring the basic settings of the Visitor Management System software module.
Advanced settings of the Visitor Management System
software module

The Visitor Management System software module's advanced settings are configured as follows:

1. Go to the Visitor Management System object's settings pane.

Display T Disable
Display 1

B Coriitn cand srizred by opsraion




2. Click the Configure button in the Advanced settings field
The Advanced settings window will open.
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3. In the Viewed fields settings group, configure how fields are displayed on the user pane for different departments:
1. On each tab check the box next to the fields to be displayed on the user pane of the corresponding
department (1).

Note:

If all basic fields or all advanced fields should be displayed, check the All fields and All extra
fields boxes, respectively.

2. If user access levels should be displayed, check the corresponding box (1).
4. If the Scanning documents application in the Visitor Management System module should be activated, check the
corresponding box.
5. Configure the interface of the Scanning documents interface:
1. In the Documents (tabs) settings group, check the boxes next to the actions that the Visitor Management
System module operator will be allowed perform with documents in the Scanning documents application (2).
2. In the Pages (images) settings group, check the boxes next to the actions that the Visitor Management
System module operator will be allowed perform with images in the Scanning documents application (2).
3. To enable the ability to assign a photograph to users from the Scanning documents application, check the A
ssign picture to employee box (2).
6. Configure the criteria for duplicate records:
1. Check the Set parameters for duplicate records box if Visitor Management System module operator
should be warned about duplicate user accounts when creating a new record (3).
2. Set the radio button to the desired criteria for identifying duplicate records.
Criteria for duplicate records:

Criteria Description

Surname only A new record will be considered a duplicate if the
user's surname matches that of a previously
created user.

Name only A new record will be considered a duplicate if the
user's name matches that of a previously created
user.

Patronymic only A new record will be considered a duplicate if the

user's patronymic matches that of a previously
created user.

Name and surname A new record will be considered a duplicate if the
user's name and surname match those of a
previously created user.

Full name



A new record will be considered a duplicate if the
user's full name matches that of a previously
created user.

7. To save changes and return to the Visitor Management System object's settings pane, click Save.

Note:

To return to the Visitor Management System object's settings pane without saving changes, click Cancel

8. Click Apply on the Visitor Management System object's settings pane.

This completes the process of configuring the advanced settings of the Visitor Management System software module.

Visitor Management System software
module interface

Basic elements of the Visitor Management System
software module

The Visitor Management System software module's interface consists of three basic elements:

1. ACS bar (1);
2. Information pane (2).
3. Toolbar (3);

ill Visitor Management System - ACS

Correction  Wiew Service Help

o)
y

€9 Time schedules
=& Shift work

%4 Holidays

‘:tJ ficess levels
=-88 Departments
88 Department 3

&8 Department Clisnts
88 Departrment Emplovess

ACS bar

11
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The ACS bar is designed for switching between the sections of the software module. It displays the hierarchical
department tree.

The ACS bar supports editing of the department tree by adding, deleting, and renaming departments, if the module
operator possesses the appropriate rights.

Switching to any section of the software module changes the information pane.

Information pane

The information pane is designed to display and edit existing (created) time zones, access levels, holidays, shift schedules,
departments, and all users of the selected department.

Toolbar

The toolbar is designed to switch between the ACS bar and the search bar. The toolbar also supports the following actions:

Start the Scanning documents application.

Start printing a user access card.

Assign a photograph to a user.

Change the appearance of the information pane.

AWNRE

Visitor Management System software module interface
settings

Configuration of the appearance of the menu and toolbar

To configure the appearance of the Visitor Management System software module's menu and toolbar, do the following:

1. Go to the Service menu.

+# Visitor Management System - Departments

Setting...

ACS bar 1% Style 2005

= & acs Style 2003
{0 Tme schedule 2K
,:3 Shift: work: e
';;' Fmays =P St‘;."lB P
& Access levels ¥
= B8 Departmeants
8 Department 3
84 Department Clisnts
&8 Department Emplovees

2. Select the Setting... menu item.
The Setting window will open.

x|

Configurable menus and toolbars

W Use animation when
expanding menu

v Show menu shades
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ow tooltips Tar
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15.

. Check the Always show full menu box if all menu items should be shown immediately (1).
. Check the Show full menu after short delay box if all menu items should be shown after holding the mouse

cursor over the down button for a while(2).

. Check the Highlight rarely used commands box if rarely used menu items should be highlighted (3).

. Check the Use animation when expanding menu box if the menu should be animated when it expands (4).

. Check the Show menu shades box if the menu should cast shadows (5).

. Click the Reset command usage statistics button to reset menu item usage statistics ( 6).

. Check the Large icons in toolbars box if large icons should be used in the toolbar (7).

. Check the Large icons in menu box if large icons should be used in the menu (8).

. Check the Show tooltips for commands in toolbars box to display tooltips when the mouse cursor hovers over

an icon on a toolbar (9).

. Check the Show tooltips for commands in menu box to display tooltips when the mouse cursor hovers over a

menu item (10).
Check the Add keyboard shortcuts to tooltips box to include the keyboard shortcut for actions in tooltips (11).
Select the desired menu animation from the Menu output effect dropdown list (12).

Note:

If animations are not required, select None.

To save any changes made, click the Apply button.

Note:

To cancel your changes, click the Cancel button.

This completes the process of configuring the appearance of the menu and toolbar.

Configuration of the Visitor Management System module's
window style

The Visitor Management System module's window style is configured as follows:

1.

2.

Go to the Service menu.

:# Visitor Management System - Departments

: File Correction ‘iew | Service | Help

|58 acs | search | Setting... I
ACS bar Style 2005 W B
= & acs Style 2003

Skvle 2K

Skyle ®P }

1

T2 Shift wark,
5l Holidays
& Access levels
= Departments
88 Department 3
88 Department Clients
88 Department Employees

Select the menu item that corresponds to the desired style.

This completes the process of configuring the Visitor Management System module's window style.

Configuration of the information pane's view

The information pane's view is configured in three ways:

1.

Using the information pane's context menu:
1. Go to the section of the Visitor Management System software module which is to have its view configured
by clicking with the mouse on the desired item in the ACS bar.
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2. Right-clicking anywhere on the information pane will bring up the context menu.

(x¥) ~ 8& %
Department Department Department Department
Clients Traffic Employees Visitors
| View b |Z| Icons
1 New Cirl+N List

Rename Table
Delete Del Grid
Arrange Icons 4

3. Select the View menu item and select the desired view for the information pane from the flyout menu.
2. Using the toolbar:

1. Go to the section of the Visitor Management System software module which is to have its view configured
by clicking with the mouse on the desired item in the ACS bar.

2. Click the m button on the toolbar.
3. Select the desired view for the information pane from the dropdown menu.

R-|&-2 > |
_IE' Icons

List

Table

Grid

¢
3. Using the menu:

4. Go to the section of the Visitor Management System software module which is to have its view configured by
clicking with the mouse on the desired item in the ACS bar.
5. Go to the View menu.

¥ Visitor Management System - Departments

: File Correction W Service  Help
55 acs| el View s Icons
ACS bar ACS bar [o] List s
5§ ACS “%  Search bar Table |
i 0
Qo w P
5l Holiday ¥

-@ Access levels
=54 Departments
&4 Departrment 3
&4 Departrent Clients
&4 Department Employess

6. Select the View menu item and select the desired view for the information pane from the flyout menu.

This completes the process of configuring the information pane's view.

Visitor Management System software module pane display
settings

The display of the Visitor Management System module's panes is configured as follows:



1. Go to the View menu.

® Visitor Management System - Depariments

i Al Correction | Yisw | Service Helo
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To display the menu, put a check next to Menu bar item by clicking on it (1).

To display the menu, put a check next to the Menu bar item by clicking on it (1).

To display the interface style selection pane, put a check next to the Interface bar item by clicking on it (1).

To display the status bar below the Visitor Management System module's window, put a check next to the Status
bar item by clicking on it (2).

aua b wnN

This completes the process of configuring the display of the Visitor Management System software module's panes.

Moving the Visitor Management System software module's panes

To enable the movement of the Visitor Management System module's panes, put a check next to the Allow bar moving
by clicking on the corresponding item in the Service menu.

:9 Visitor Management System - ACS

: File Correction  Wiew | Service | Help

&8 acs | search | Setting. ..
ACS bar € Allow bar moving ) |
= E ACS Resel settings
@ Time schedules "
= shift work 75 | Shyle 2005

%) Holidays Style 2003 |

==
&5 Access levels
2K
= Departments S e

&8 Departrmerd ¥ Style 3P
&8 Departrent Cherts
&8 Department Employees

Movement of the Visitor Management System software module's panes is configured as follows:
1. Left-click the pane's header with the mouse.
2. While holding down the left mouse button, move the mouse cursor to the desired area of the Visitor Management

System module's window.
3. Release the left mouse button.

Following these steps will result in the pane being moved to the specified location.

Working with the Visitor Management
System software module
Working with time zones

15
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In the Visitor Management System software module, a time zone defines the time interval in which users access objects. A
single time zone can contain several time intervals.

Creation of a time zone

A time zone is created as follows:

1. Go to the Time zones section of the ACS bar.

ACS bar

Elﬁ Departments

----- & Department Employees

£ Department Visitors
: %, Department Clients
... % Department Traffic

The information pane will show previously created time zones and the time zone bar will open.

Time zone bar

Mum... |1 ame ime zone 1

f Beginning ding onday | Tuesday | Wednesday | Thursday |Friday | Saturday | Sunday | Holidays
L\ r r r r r r r r -/
3 4 &)

Save Mew Delete
6 1

2. Click the New button (1).

[ wom ][]

Note:

This action can also be performed using the information pane's context menu. Right-click on any point in
the information pane to bring up the context menu and then select the New menu item.

Wiew L4

L Mew Ctrl+N

Arrange Icons 4

3. In the Name field, enter the name of the time zone (2).

4. Configure the time zone's intervals. For each interval, do the following:
1. In the Beginning column of the table, enter the time interval's start time in HH:MM:SS format (3).
2. In the Ending column of the table, enter the time interval's end time in HH:MM:SS format (4).
3. To include a day of the week in the time interval, check the box in the corresponding column (5).
4. Check the Holidays box to include holidays in the time interval (5).

5. Click Save to save the time zone (6).

The completes the process of creating a time zone.

Editing a time zone

A time zone is edited as follows:
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1. Go to the Time zones section of the ACS bar.

-] Access levels
=84 Departments

i Department Employees
£\ Department Visitors
|, Department Clients
Department Traffic

2. Select the desired time zone in the information pane by clicking on it with the left mouse button
Mever Always

3. Go to the time zone bar and make the desired changes.
4. Save the changes by clicking Save.

This completes the process of editing a time zone.

Deleting a time zone
A time zone is deleted as follows:

1. Go to the Time zones section of the ACS bar.

(% SNITE worl
’f;,] Holidays
: j:-j Arcess levels
=88 Departments
ﬂ! Department Employess
..\@ Department Visitors
|, Department Clients
L% Department Traffic

2. Select the desired time zone in the information pane by clicking on it with the left mouse button.
Mewver Always

3. Click Delete on the time zone bar.
Note:

This action can also be performed using the Delete item in the information pane's context menu.
4. Click Yes to confirm the deletion.

The completes the process of deleting a time zone.

Working with shift schedules
Creation of a shift schedule

A shift schedule is created as follows:
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1. Go to the Shift work section of the ACS bar.

ACS bar

----- -L:t-j Access levels
=58 Departments

-8 Department Employees
“El Department Visitors
%, Department Clients

... % Department Traffic

The information pane will show previously created shift schedules and the shift work schedule bar will open.

Shift work schedule bar oo

I ot start Skip holidays ) &

Shift time {number
of days in a shift

10 1 [ Rowl ]
2. Click the New button (1).
Note:

This action can also be performed using the information pane's context menu. Right-click on any point in
the information pane to bring up the context menu and then select the New menu item.

View ¥
1 New Ctrl4M

Rename

Arrange Icons bk

In the Name field, enter the name of the shift schedule (2).

Specify the shift's start date in the Shift start field in DD.MM.YYYY format (3).

Check the Skip holidays box to ignore holidays (4).

In the Shift time spinbox, use the up/down buttons to enter the total number of days in the shift schedule,
including days off (5).

oukw

Note:
The current shift day is displayed in the corresponding field (6).
7. Configure the shift schedule's workdays. For each day, do the following:
1. In the Shift day column, enter the shift day's index number (7).
2. In the Beginning column of the table, enter the workday's start time in HH:MM:SS format (8).

3. In the Ending column of the table, enter the workday's end time in HH:MM:SS format (9).
8. Click Save to save the shift schedule (10).

This completes the process of creating a shift schedule.

Editing a shift schedule

A shift schedule is edited as follows:
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1. Go to the Shift work section of the ACS bar.

& Access levels
-84 Departments
ﬂ! Department Employess
-.\\@ Department Visitors
.}, Department Clients
... %% Department Traffic

2. Select the desired shift schedule in the information pane by clicking on it with the left mouse button.

hift wark hift wark
schedule 1 schedule 2

3. Go to the shift work schedule bar and make the desired changes.
4. Save the changes by clicking Save.

This completes the process of editing a shift schedule.

Deleting a shift schedule

A shift schedule is deleted as follows:

1. Go to the Shift work section of the ACS bar.

ACS bar

-*E Arccess levels
-8 Departments

ﬂﬂ Department Employees
il Department Visitors
-5 Department Clients

. Department Traffic

2. Select the desired shift schedule in the information pane by clicking on it with the left mouse button.

hift work hift wark
schedule 1 schedule 2

3. Click Delete on the shift work schedule bar.

Note:
This action can also be performed using the Delete item in the information pane's context menu.

4. Click Yes to confirm the deletion.

This completes the process of deleting a shift schedule.

Working with holidays

Holidays can be included in time zones and shift schedules.

Assigning holidays

Holidays are assigned as follows:
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1. Go to the Holidays section of the ACS bar.

g Access levels
=84 Departments

88 Department Employees
Af Department Visitors
% Department Clients

. % Department Traffic

The pre-holiday bar will open in the information pane.

Pre-holidays bar

2. Enter the dates of the holidays in DD.MM.YYYY format in the Day column (1).

Note:

Holidays must not be duplicated.

3. To save any changes made, click the Save button (2).

This completes the process of assigning holidays.

Deleting holidays

Holidays are deleted as follows:

[ wom][ ]
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1. Go to the Holidays section of the ACS bar.

4| Access levels
Departments

----- & Department Employees

- £} Department Visitors

, Department Clients
... %gh Department Traffic

The pre-holiday bar will open in the information pane.

Pre-holidays bar

| =

08.03.2013

01.01.2013
| 01.01.2m2

Save

[ .
2. Bring up the holiday context menu. Do this by left-clicking with the mouse in the corresponding table cell.

1 Mew record Ctrl+M
Delete record  Cirl+Del

$ Cut Ctrl+X

T\ copy Cirl+C

1\ Paste Ctrl+v
Select all Ctrl+A

Select record Ctrl+R.

% Find... Ctrl+F

3. Select the Delete record menu item.
4. To save any changes made, click the Save button (2).

This completes the process of deleting holidays.
Search for holidays by date
Search for holidays by date as follows:

1. Go to the Holidays section of the ACS bar.

ACS bar

o] Access levels
=84 Departments

----- & Department Employees

il Department Visitors
% Department Clients
& Department Traffic
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The pre-holiday bar will open in the information pane.

Pre-holidays bar

Nurm... I1

Name [Holidays

Day

08.03.2013
01.01.2013
[ |01.01.2012

|

Save

[ Iom][ ]
2. Bring up the holiday context menu. Do this by left-clicking with the mouse in the corresponding table cell.
Mew record Ctrl+M
Delete record  Ctrl+Del
g Cut Ctrl+%
£\ Copy Ctrl+C
1\ Paste Ctrl+V
Select all Ctrl+A
Select record Ctrl+R
_% Find... Cirl+F

3. Select the Find menu item.
The Search window will open.

Search x|
sample: 1 ]}C Find j?
Vew  2(A HC e 4 mﬂ
Match: 3 CWhole fiskd 3%?5

4. Specify the search parameters:
1. In the Sample field, enter the search query (a complete or partial holiday date) (1).
2. Select the direction of holiday search from the View dropdown list (2).
3. Select the search type from the Match dropdown list (3).

Search type Description

Whole field The search will find holidays with dates that
entirely match the search query

Field beginning The search will find holidays with dates that begin
with values that match the search query

Any field part The search will find holidays with dates that
contain the search query

4. To perform a case sensitive search, check the corresponding box (4).
5. To perform a field-format sensitive search, check the corresponding box (5).
6. To search only in the current field (e.g. the field from which the context menu was brought up), check the
corresponding box (6).
5. Click the Find button to begin the holiday search (7).
If no matching dates are found, a message about the unsuccessful search will appear in a popup window.



[ coess Controlsystem

l ,  Value not found

If a matching holiday is found, then a — icon will appear next to it in the list.
Day |

01.01.2012

~ |01.01.2013

b |02.02.2013 |

6. To continue the search, click the Find next button (8).
7. To end the search and close the search window, click Close (9).

This completes the process of searching for holidays.

Working with access levels

In the Visitor Management System software module an access level is a set of special restrictions defined by users' rights
to access and move about a protected object.

An access level determines which access point (reader) for a given time zone (shift schedule) will provide user access and,
if necessary, forward cards to a controller and armed/disarmed for an object.

Creation of an access level

An access level is created as follows:

1. Go to the Access level section of the ACS bar.

Time zones
Shift waork:

Departments

84 Department Employees
i\ Department Visitors

i 8 Department Clients
.. %8 Department Traffic

The information pane will show previously created access levels and the access level bar will open.

Access level bar

Hum... I Name 2

 p—
‘rAccess poirt f Time zoneYhard transfer |An'r| | Disam d
' - F
3 4 3 =
Save Mew Delete
6 1 T

2. Click the New button (1).

Note:
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3.
4.

8.

9.

This action can also be performed using the information pane's context menu. Right-click on any point in
the information pane to bring up the context menu and then select the New menu item.

View r

&

Arrange Icons g

In the Name field, enter the name of the access level (2).
In the Access point column of the table, select the reader through which user access will take place (3).
Note:

Each reader can only be used once. An error message will appear if you attempt to use a reader multiple
times.

Visitor Management System

Field ‘Access pont’ value must not be duplicate.,
l b Please enter another value.

=T

. In the table's Time zone column, select the time zone (or shift schedule) in which access will take place through

the access point (4).
Check the box in the table's Card transfer column to forward access cards to the controller after an access card
has been presented by a user (5).

. Check the box in the table's Arm column to arm the access point after an access card has been presented by a

user (5).

Check the box in the table's Disarm column to disarm the access point after an access card has been presented by
a user (5).

Click Save to save the access level (6).

This completes the process of creating an access level.

Editing an access level

An access level is edited as follows:

1.

2.

Go to the Access level section of the ACS bar.

Time zones
":h@. Shift work
%4| Holidays
Departments

ﬂl Department Employees
£| Department Visitors
%, Department Clients
...%% Department Traffic

Select the desired access level in the information pane by clicking on it with the left mouse button.

Access level 1 Access level 2

3. Go to the access level bar and make the desired changes.
4. Save the changes by clicking Save.
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This completes the process of editing an access level.

Deleting an access level

An access level is deleted as follows:

1. Go to the Access level section of the ACS bar.

Time zones
o Shift work
%) Holidays

i Departments

ﬂﬂ Department Employees

‘£ Department Visitors
. Department Clients
. %gs Department Traffic

2. Select the desired access level in the information pane by clicking on it with the left mouse button.

o

Access level 1 Access level 2

3. Click Delete on the access level bar.

Note:
This action can also be performed using the Delete item in the information pane's context menu.

4. Click Yes to confirm the deletion.

This completes the process of deleting an access level.
Working with departments
Creation of a department

There are two ways to create a department in the Visitor Management System software module:

1. Using the context menu on the ACS bar:
1. Go to the Departments section of the ACS bar.

Time zones
“h Shift work
%) Holidays

]

B

Access levels
<44 Department Employees
\#l Department Visitors
%, Department Clients
Department Traffic

2. Bring up the context menu by right-clicking on the Departments section.

Create department ¢ Employess  Cirl+M
4 '“% Find department... Ctrl+F Visitors
Sort Clients
v Traffic




3. Select Create department and select the desired department type from the flyout menu.
This completes the process of creating a department.
2. Using the information pane's context menu:
1. Go to the Departments section of the ACS bar.

Time zones
5 Shift work
%) Holidays

Y

‘ Access levels
A Departmens

-« Department Employees
£ Department Visitors
%, Department Clients
i Department Traffic

2. Bring up the context menu by right-clicking on any point on the information pane.

2 « & g

Department Department Department Department
Clients Traffic Employees Visitors

View 4

Arrange Icons 4

3. Select the New menu item.

Attention!

This method only creates Employee-type departments

This completes the process of creating a department.

Assignment of department properties

Department properties are assigned on the department properties pane. This pane is displayed on the ACS bar when
selecting any department.



ACS bar

= & acs
@ Tirme schedules
% shift wark
’é] Holidays
-*:[-j Access levels
=58 Departments
&4 Department Clients

Department Employees
&8 Departrnent Traffic

@_artment propetties bar

Mumber Z

I ame Department Employess
Type Employees

Arcess level Full access

Mumber of department employees

Department properties are assigned as follows:

27
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2 )

J/

1. In the External ID field, enter the department's external identification number (1)

Department properties bar

®

Mum...

MName

Ty...
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2. In the Name field, enter the name of the department (2).
Select the department type from the Type dropdown list (3).
4. Select the department's access level from the Access level dropdown list (4).

w

Note:

The number of employees in the department is indicated in the corresponding field (5).

5. In the Extra AL fields, specify the department's additional access levels, if any have been set up in the software

module (6). See also Basic settings of the Visitor Management System software module.
6. Click Save to save the changes (7).

This completes the process of assigning department properties.

Building a department hierarchy

By default, a department is created as a base department, i.e. a parent department. To build a hierarchical department

structure, change department parents as desired.
Department parents are changed as follows:

1. Bring up the context menu of the desired department on the ACS bar or the information pane.
-8 Departments

----- ¥ M Department Employees

""" @ D Create department L |
& D
%D Rename

Delete Del

Import employees  Cirl+Enter
Impart child departments

“%  Find department... Ctrl+F
Sort

Change parent...
Department properties

2. Select the Change parent... menu item.
The Change department parent window will open.

Change department parent

Elm Departments
= 8, Department Clients
Elﬂ Department Employees

ﬂ Development Department 1

.4 Ressarch Department 1
% Department Traffic

“-Ag Department Visitors

OK

3. Click on the department to be designated the parent department for the selected department.
4. Click OK.




This completes the process of changing the department parent.
Department search
Departments are searched as follows:

1. Bring up the context menu of the Departments section.

Create department L

Renarme

1]
]
1
]
i

L=}
[=]
i)
=
[=]
i
m
(4]
(]
I
m
A
m

i)
=
]
[11]
=]
(L
m
3
g

Import cl

—~% Find department... Cirl+F

Sort

Change parent...

Department properties

2. Select the Find department... menu item.
The Search window will open.

3. Enter the complete or partial name of a department in the field (1).
4. Click the Find button (2).

If the search is successful, the matching department is selected on the ACS bar. Otherwise, a message about the
unsuccessful search will appear in a popup window.

Visitor Management System E|

L] E Department ‘manufackure’ not Found
L

This completes the process of searching for a department.

Sorting the list of departments on the ACS bar

To sort the list of departments on the ACS bar alphabetically, do the following:

1. Go to the Departments section of the ACS bar.

Time zones
“h Shift work
%) Holidays
5] Access levels

@ Deportrenis

g4 Department Employees
£ Department Visitors
%, Department Clients
------ % Department Traffic
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2. Bring up the context menu.

Create department L
Rename

Elg. Delete Del
Import employees  Cirl+Enter
Import child departments

<% Find department... Ctrl+F

Sort

Change parent...

Department properties

3. Select the Sort menu item.

This will sort the list of departments alphabetically.

Deleting a department
There are two ways to delete a department in the Visitor Management System software module:

1. Using the context menu on the ACS bar:
1. Go to the Departments section of the ACS bar.

Time zones
Shift wark
Holidays
Access levels

2 Department Employees
\#l Department Visitors

%, Department Clients

. Department Traffic

)
o

o

2. Bring up the context menu of the department to be deleted.

Create department L4

Rename
|5 Delete Del

(]
t
}
rm
|
m

lmport empioyees

|

lmport cnid deparmments

s

<% Find department... Cirl+F
Sort

Change parent...

Departrment properties

3. Select the Delete menu item.
This completes the process of deleting a department.
2. Using the information pane's context menu:

30
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1. Go to the Departments section of the ACS bar.

g8 Department Employees
£\ Department Visitors
|, Department Clients
Department Traffic

2. In the information pane, bring up the context menu of the department to be deleted.

Create department L
Rename

|5 Delete Del

Import employees  Cirl+Enter
Impart child departments

<% Find department... Ctrl+F
Sort

Change parent...

Department properties

3. Select the Delete menu item.
This completes the process of deleting a department.

Working with users
Creating a user

A user is created as follows:

1. On the ACS bar, go to the department in which the user is to be created.
2. In the information pane, bring up the context menu by right-clicking on any point on any empty space in pane.

View »

O New Ctrl+N

QE.-\.E.“E

L]
[l

ete Del

Arrange Icons L4




3. Select the New menu item.
The user pane is displayed below the information pane.

Properties I Extra I

Number 3 Personnel Mo, External ID

Surname User 3

Name: Patronymic
Passport License
Department Department 2

Position Telephone

Make Number

™ User locked ™ Antipassback
Object code PIM

Card Card lost. 2| times
Issued by
Expiry date | Issuedate  23.07.2015 15:1

Access level General i

Scan

7]

AL assigned b
e 501 Assign picture =

Temporary AL .

From To

Extra AL [Extra temporary AL
Extra AL 1
Extra AL 2
Extra AL 3 3
Extra AL 4

[amy] »

)
tn
o
=
@

Note:

Depending on the type of department the user belongs to, the user pane will be named as follows:
Employee bar, Client bar, etc.

4. Specify the required user properties (1).

Field Format Description
1 Number Text field User number
2 Personnel Text field User personnel number
3 External ID Text field User ID in the external

database
4 Surname Text field User's surname
5 Name Text field User's name
6 Patronymic Text field User's surname
7 Passport Text field Passport number
8 License Text field Driver's license number
9 Department Dropdown list Department to which the
user belongs

10 Position Text field User's position
11 Telephone Text field Telephone number
12 Make Text field Make of user's car
13 Number Text field User's car number
14 User locked Checkbox Yes - the user is locked.

No - the user is active.
15 Antipassback Checkbox Yes - anti-passback enabled.
No - anti-passback disabled.

16 Object code Text field Facility code of the user's
access card

17 PIN Text field PIN code of the user's
access card

18 Card Text field User's access card number

19 Card lost___times Text field
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Number of times the user
has lost his or her access

card
20 Issued by Text field Employee who issued the
access card to the user
21 Expiry date Text entry or date selector Date the user's access card
expires
22 Issue date Text entry or date selector Date the access card was
issued to the user
23 Access level Dropdown list User's access level.
If Group access level is
selected, the user is
assigned the access level of
the department to which he
or she belongs.
24 AL assigned by Text field Employee who assigned the
access level to the user
25 Temporary AL Dropdown list Temporary access level
26 From Text entry or date selector Start date for the temporary
access level
27 To Text entry or date selector End date for the temporary
access level
28 From where (visitor bar Text field Name of organization to
only) which the visitor belongs
29 To where (visitor bar only) Dropdown list Department being visited
30 To whom (visitor bar only) Dropdown list Employee being visited
Extra AL Dropdown list Additional access level of
employee
Extra temporary AL Dropdown list Additional temporary access
level of employee
Note:

The object code and card code of the user's temporary access card are entered in the Object code and Ca
rd code fields after the main access card's object code and card code, separated by a space.

Note:

To display data in the External ID field, check the Export data and Import data on the Visitor
Management System object's settings pane (4).

Attention!

Assigning of several access levels to employee is possible only in the following ACS systems: ApolloSDK, El
sys, ParsecNet, HID, Suprema, Salto, Perco S20.
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5. Go to the Extra tab.

ap

Bxtra info

6. Specify the advanced user parameters (1).

Note:

The addition of advanced parameters to the user pane is described in Adding additional user parameters.

7. If needed, enter additional user information in the corresponding field (2).
8. Click the Save button (3).

This completes the process of creating a user.

Transferring a user to a different department

There are two ways to transfer a user from one department to another:

1. Using the user pane, which opens by double-clicking on the user in the information pane:



1. From the Department dropdown list, select the department to which the user is to be transferred (1).

Employee bar
Properties 40
MNUm... 1 Personnel I:I External ID
Surname Smith
MName John Patronymic
Passport License 1 NO PHOTO
@epart'nent Department Employees 3
Position Telephone
Make Num...
[ User locked [~ Antipassback
Object code PIN
Card Card lost E times |:’ Sean |
Issued by @ Assign picture -|
Expiry date Issue date | Prirt access card |
Access level Group © | Delete |
AL assigned by
| Import |
Temporary AL -
| New |
F.. To
™ | L aaT—
NV

2. Click the Save button (2).
This completes the process of transferring a user from one department to another.
2. Using the information pane's context menu:
1. Bring up the user context menu.

E W

iEew »
T New Ctrl 4+
Rename
_'ﬁ
Gransfer employee to another department...  Cirl-+M ___,I'
Emplo Import employee Cirl+Enter
Arrange Icons L4

ﬁmrr‘l:ﬂ"ﬂ'EI



2. Select Transfer employee to another department...
The Transfer employee to another department window will open.

Transfer employee to another department

=88 Departments
-8 Department Clients
Eﬂl Department Employees
. L.8& Development Departmert 1

----- % Department Traffic
A Department Visitors

OK || Cance

3. Select the department to which the user is to be transferred.

4. Click OK.
This completes the process of transferring a user from one department to another.

Assigning a photograph to a user

There are two ways to assign a photograph to a user:

1. By selecting a photograph from a file.
2. By capturing a picture from a video camera.

Selecting a photograph from a file

To select a photograph from a file, do the following:

1. Go to the user pane and click Assign picture.

Impart picture from DB

= Tre LS

2. Select the Select picture from file... menu item and select a file with the user's photograph in the window that

opens.

The selected photograph will subsequently be displayed in the user pane.

Note:

To save changes, click Save on the user pane.

Capturing a picture from a video camera

To capture a picture from a video camera, do the following:

36




1. Go to the user pane and click Assign picture.

E""|

[} Assign picture
Select picture from file...

CTakE picture from camera.. __)

Import picture from DB

2. Select the Take picture from camera... menu item.

The Picture from camera window will open.
[ icture rom camera x

NO PHOTO

3. Use the Enter button to capture a picture from the video camera (2).
The captured frame will be displayed in the right side of the window.

Note:
To rotate the image by 90 degrees, check the Flip checkbox (3).

4. Click the OK button (1).

The captured picture will subsequently be displayed in the user pane.

Note:

To save changes, click Save on the user pane.

Creating a single photograph database
The ACFA Intellect Software System supports storing user photographs on several computers

The ACFA Intellect Software System's advanced settings utility tweaki.exe is used to create a single photograph database.
There are two ways to launch the tweaki.exe utility:

1. From the Windows Start menu: Start ->All Programs ->Intellect ->Utilities ->Advanced settings.
2. From the Tools folder of the ACFA Intellect Software System's installation directory: <Intellect installation

directory>\Tools\tweaki.exe .

To configure the creation of a single photograph database, do the following:

37



1. Select the Visitor Management System mode in the Intellect Advanced Setup window (1).
 Intellect® Advanced Seiup 3|

- [ Windows . 3

-0 Intellect

&d cormiguration

[> Compressing MS Access DB [ \\.
‘o[> MSDE (MS 5QL) configuration

----- [> Video subsystem

----- [> Testing video capture cards

..... )] Telemetry

----- [» POS-ntellect

..... [> Version

OK

2. In the System identifier column, enter the names of the computers that will store the photographs assigned by a
user using the Visitor Management System module (2).
Note:

The specified computers must be connected to the Intellect Server. Detailed information about configuring
server connections is given in Intellect Software System: Administrator's Guide. However, the Visitor
Management System module does not have to be installed on the specified computers.

Note:

Only photographs that have been newly added using the Visitor Management System module will be
placed on the specified computers. Photographs added to the system before the configuration of the
creation of a single photograph database will not be distributed to these computers.

Note:

Photographs will be stored on both the computers specified using the tweaki.exe utility as well as the
computer from which photographs are added. Added photographs are stored in: <Intellect installation
directory>\Bmp\Person.

3. Click the OK button (2).

This completes the process of configuring the creation of a single photograph database.

Printing a user access card

A user access card is printed as follows:


https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171

1. Go to the user pane.

> Scan

|@ Assign picture -

{| Prirt access card b

| Impaort |

| Mew |

| Save |

2. Click Print access card.
The Print window will open.

O

x|
Template: 1 S
C B

3. From the dropdown list, select the template for printing the access card (1).

Note:
Print templates are prepared in the utility ArpEdit, which is included with the Intellect Software System in
<Intellect installation director>/Tools/Arpedit/. A description of the utility is given in ArpEdit.pdf.

4. Click the Print button (2).

This completes the process of printing a user access card.

User search

i [oHc on the ACS bar.

Searching for users happens on the search bar, which is brought up by click the
There are two ways to perform a user search:

1. Specify the search parameters:

 Any field part >4
@Em’mum size 1000 )5

| Fnd | | Stop | MNew
=6 7@ D

Mame Value ar
ard = 4154 = 4122

g8 L a | 1o




40

whn

SvowNOu;

. In the Search for field, enter the word or value to be searched for (1).

Note:
The search is not case sensitive.
From the Search in dropdown list, select the type of departments that will be searched ( 2).

From the Field dropdown list, select the field that will be searched (3).
Select the search type from the Match dropdown list (4).

Search type Description
Whole field A search that will find users for which the search
field entirely matches the value entered in the Fin
d what field.
Field beginning A search that will find users for which the start of
the search field matches the value entered in the F
ind what field.
Any field part A search that will find users for which the search
field contains the value entered in the Find what
field.

In the Maximum size field, enter the maximum number of results to be displayed (5).

Check the Extra fields box if the search parameters should include other values and fields (6).
Click Add to add a field (7).

From the dropdown list, select the field that will be searched (8).

Enter the value that should be contained in the selected additional field (9).

In the Or columns, enter other values that the selected additional field may contain (10).

This completes the process of specifying the search parameters.

Note:

An example of a search with additional parameters is given below.

The following parameters have been specified for the search:

a substring search to find the value Ivanov in the Surname field in Employee-type

departments. The additional field Card and values 4154 and 4122 have been specified.

Search results:

the search returns users from Employee-type departments who have a surname that contains Iva
nov and whose Card field is equal to 4154 or 4122.

2. Start the search by clicking Find (1).

Note:

ITILLAI T A

[RTET

To stop a search, click the Stop button (2). To specify new search parameters, click the New button (3).

After the search has finished, users that match the specified search criteria will be displayed in the information pane. The
number of matching users will be indicated in the lower left corner of the pane.

Search finished

2 found

This completes the process of searching for users.

Adding additional user parameters

The Visitor Management System software module supports adding additional user parameters.

To add additional parameters, add rows to the OBJ_PERSON table and update the ACFA Intellect Software System

database.
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Caution!

The ACFA Intellect Software System must not be running when adding additional fields.

Additional parameters are added as follows:

1. Open the ddi.exe utility located in <Intellect installation directory>/Tools/.

£ DDI & DBI Editor - [C:\Program Files\WuTennext \intellect.dbi] 18] x|
o
ool DB 2 Y Field name Type Size
3 F quid UMIQUEIDEMTIFIER
3 Nk J

=

[OBJ_PERSON]
quid. UNIGUEIDENTIFIER

Total objects: 164

2. Open intellect.exe.dbi by selecting Open in the File menu (1).

Attention!

This file is currently not included with the ACFA Intellect Software System. Contact ITV customer support
to receive intellect.exe.dbi. The file should be placed in the ACFA Intellect Software System's installation

directory.

3. Go to the DBI tab (2) and select the OBJ_PERSON table (3).




4. To create a new field fill the row marked with the * :

=loix]
File
(n]] DBI | Field name Type Size Description
m 3 aquid UMIDUEIDENTIFIER -
* ( C X X )
1 2 3 4

[OBJ_PERSON]
quid, UNIQUEIDENTIFIER

Total objects: 164

Enter the field name (1).

AWNH

Management System software module's window (4).
5. Add the required number of fields.
6. Save the changes to file by selecting Save in the File menu
7. Update the ACFA Intellect Software System database:
1. Open the idb.exe utility located in the ACFA Intellect

Y1108

Select data source:

Select the type of the field being added from the Type dropdown list (2).
In the Size field, enter the size in bytes of the field being added (3).
In the Description field, enter the name of the field being added, which will be displayed in the Visitor

(1).

Software System's installation directory.
o x|

Description:

IBasic data j
l7 Use

Move database Build |

Connection string:
I Provider=SQLOLEDE. 1;Integrated Security=55PI;Persist Security Info=False;I

Select dbi-file:

“Intellect” main database

=

Select ddi-file:

AHTennex intellect. dbi

3|

C:\Program Files)

I C:\Program FilesYHTennekt \Languages'eniintellect. ddi

Select action
Canyert M5 Access bo M5 501 database |

Create backup copy (MS SQL)

Restore from backup (M5 SQL) |

D1

Additional tools
% Update database

Create dbi-file |

Protocal

2. Click the Update database button (1).
3. After the database update is complete, click OK (2).
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8. Start the ACFA Intellect Software System and the Visitor Management System software module, and go to the Extre
tab on the user pane.

Search finished
2 found

The added parameters will be displayed in the Visitor Management System software module's window.
This completes the process of adding additional parameters.

Scanning user documents

Scanning user documents is performed in the Scanning documents application. Working with the Scanning documents
application is described in Working with the Scanning documents application.

Canceling user cards
If a user belongs to the Visitors group, his or her access card can be canceled.
To cancel a visitor's access card, do the following:

1. Go to the visitor bar.

» Scan

|ﬁ Assign picture -

| Print access cand |

C o)

MNew

[
| Jdve |

2. Click Discharge card.
3. Confirm the cancellation of the access card by clicking Yes.

Visitor, Management System r5_<|

Are you sure you want to discharge card
Toe "7

(]| =

As a result, the user will be deleted from the Visitors department.
This completes the process of canceling a user's access card.
Deleting a user

A user can be deleted in two ways:

1. Using the context menu:
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1. In the information pane, bring up the context menu of the user to be deleted.

K
View k
1 Mew Ctrl4M
Rename
i) Delete Del
Transfer employee to another department...  Cirl-+Hv
f Import employee Ctrl+Enter

F Arrange Icons b

2. Select the Delete menu item.
3. Confirm the deletion by clicking Yes.

Visitor Management System E|

. Are you sure you want
X /.-' to delete info about
= "Foreman Susan " ?

Oa I Het

This completes the process of deleting a user.
2. On the user bar:
1. Go to the pane of the user to be deleted.

» Scan

|ﬁ Assign picture -

Prirt access card |

L
o
il

2. Click Delete.
3. Confirm the deletion by clicking Yes.

Are you sure you want
f.-' to delete info about
= "Foreman Susan " ?

This completes the process of deleting a user.

Adding user access cards using a reader

The Visitor Management System software module supports adding permanent and temporary user access cards using an
access control reader. The reader to be used to add the cards is indicated on the Visitor Management System object's
settings pane (see Basic settings of the Visitor Management System software module).

To add access cards to a user using an access control reader, do the following:
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1. Go to the user pane.

Employee bar o ox

Properties q b

Mum... 3 Persorinel External ID

Surname Foreman

MName Susan Patronymic

Passport License NO PHOTO

Department  peyelopment Department 1 T

Position Telephone

Make Mum. ..

[~ User locked [~ Antipassback
Object code 193 193 PIN

|f} Scan

Card 29921 47818 Card lost E times

Issued by |I‘ﬁ Assign picture -

Expiry date Issue date 07.03.2013 14:1 | Print access card |

Access level Group B | Delete

AL assigned by |

Import

Temporary AL - |

F.. E” To | E” 2( — D
o]

2. Insert the access card to be assigned to the user into the selected reader.
3. If the Confirm card entered by operator box is checked on the Visitor Management System object's settings
pane, a Visitor Management System dialog will be displayed.

Visitor Management System

Issue Foreman Susan ' card 47818 (198)? Yes - adds to existing,
No - replaces.

1. Click Yes if the access card being added is temporary. The object code and the card code are entered in the
corresponding fields after the codes of previously added access cards, separated by spaces (1).

2. Click No if the access card being added is permanent. The object code and card code of the inserted access
card are entered in the corresponding fields on the employee bar in place of the previously specified values.

3. Click Cancel to not add the inserted access card to the user.

4. If the Confirm card entered by operator box is not checked on the Visitor Management System object's
settings pane, then the object code and card code of the inserted card will be entered in the corresponding fields
on the employee bar in place of the previously specified values.

5. Click the Save button (2).

Note:

Temporary access cards are deleted manually.

Note:

When working with the ABC integration module, temporary cards are deleted automatically when they expire.
The ABC Integration Module Settings and Operation Guide describes how to configure the expiration date of
temporary cards for the ABC module.

This completes the process of adding a card to a user using an access control reader.

Working with the Scanning documents application

Scanning documents is an Visitor Management System module software application. The application runs in a separate
window.

Note:

Fullscreen mode is recommended for your convenience when using this application.


https://doc.axxonsoft.com/confluence/pages/createpage.action?spaceKey=acfaen&title=ABC+Integration+Module+Settings+and+Operation+Guide&linkCreation=true&fromPageId=119833363

Caution!

To use the Scanning documents application, you must first connect a scanner, and install drivers and software.

Starting and stopping the application

To start Scanning documents, click Scan on the user bar.

] Scan

|ﬁ Assign picture -

Print access card

Delete

Mew

| Import
| Save

The application window will open.

[ Scanning documents - Foreman Susan [Development Department 1] ) _ |E||1|
Zoom- .=D=.|1::=.-; | £ | & Auto zoom | | '@
Control panel o
Document name
Fassport -
|'ﬂ Add documert |
a Delete document |

|3 Delete document from list |

Pattem of saved file name

Passport
Image edit window o

File format

JPG - JPEG Files z

] Select from file |

O Use as Photo |

| Save |

| Cancel |
Zoom NUM s

x
To close Scanning documents, click the —I button in the upper right corner of the window.
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Scanning user documents with Scanning documents application

User documents are scanned as follows:

1. Go to the control panel.

Control panel oo

Uocument name

Passport
4 @ Add document )
|$ Delete document |

|)§ Delete documert from list |

Pattem of saved file name

Passport

ile format

JPG - JPEG Files

Select from file
Select the type of document to be scanned from the Document name dropdown list (1).
Enter a name template for the output file in the corresponding field (2).
From the dropdown list, select the format for the output file (3).
Click the Add document button (4).
An appropriately named tab will open on the document type navigation panel.

| = Scanning documents - Foreman Susan [Development Department 1]
' Zoom: .=|]=. 100% | | Auto zoom | | O

Passport 1F ¥

u b wnN

6. Click Scan to start the scanning application (5).

Note:

If the required document has already been scanned, it can be loaded from a file. To do this, click Select from file
and indicate the path to the desired file (6).



After the scanning is complete, an image of the document will be displayed in the document type navigation pane.

pass.jpg

Adding and deleting document types

To add a new document type, do the following:

1. Go to the control pane.

2 ‘ (= Add document ]

|$ Delete document |

2. In the Document name field, enter the type of the document being added (1).

3. Click the Add document button (2).
The document type will subsequently be available from the dropdown list (1).

To delete a document type, do the following:
4. Select the document type to be deleted from the list (1).

Note:

Only types that were previously manually created can be deleted.

5. Click the Delete document from list button (3).

The selected document type will then be deleted.
Editing an image

Editing a scanned image is performed in the image editor.
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Image edit window

Image editing is performed using the image editor's toolbar and context menu.

L Scanning documents - Foreman Susan [Development Department 1]
Zoom: D 100% T | @pavtozoom | b | T2 42 2 [ D

Cut selected
Discard selection

& Setbrightnessfoontrast
Rotate L

@ LUse as Photo

Images are edited as follows:

H

1. To select a portion of an image, click the button on the toolbar.
2. Select the desired portion of the image.

Image edit window
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3. Selecting Cut selected from the context menu will leave only the selected portion of the image on the screen.

10.

11.

12.

Image edit window

To clear the selection, select the corresponding item in the context menu.

Zoom: D
. To change the image size within the image editor, move the slider on the toolbar.
n‘f__"ﬁ Auto zoom
To automatically select the best image size based on screen resolution and window size, click the b

utton on the toolbar.

. To switch to image brightness and contrast settings, select Brightness/contrast from the context menu or click

[ 8
the button in the toolbar.
In the Brightness/contrast window that opens, use the sliders to specify the desired image brightness and
contrast. Then click OK to save the changes.

Note:

To cancel your changes, click the Cancel button.

Note:

Check the View box to immediately view the changes in the image editor.

Brightness/Contrast i

Brightre. .. 1]

Contrast: 0
| | | [ View

. To rotate the image counterclockwise by 90 degrees, select Rotate ->Rotate 90 left from the context menu or

.,
click the button in the control panel.
To rotate the image clockwise by 90 degrees, select Rotate ->Rotate 90 right from the context menu or click the
-

button in the control panel.
o
To rotate the image by an arbitrary angle, select Rotate ->Rotate image from the context menu or click the s
button in the control panel.
In the Rotate window that opens, use the slider to specify the desired angle of rotation. Then click OK to save the
changes.

Note:
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To cancel your changes, click the Cancel button.

Note:

Check the View box to immediately view the changes in the image editor.

x

Angle of rotation: 0

Cancel

[ View

13. To save changes, select Save in the context menu or click Save on the control panel.

Note:

To cancel your changes, select Cancel in the context menu or click Cancel on the control panel.

> Scan |
) Select from file |
| I B |
=] Save |
<y Cancel |

This completes the process of editing an image.

Assigning a photograph to a user in the Scanning documents
application

A portion of an image or an entire image can be used as a user photograph, e.g. displayed on the user bar.

To assign a photograph to a user, do the following:

1. Select the desired portion of the image (see Editing an image).
2. Click Use as Photo on the control panel or select the corresponding item in the editing window's context menu.

The selected portion of the image will subsequently be displayed on the user bar as the user's photograph.

Deleting documents and images

Documents and images are deleted as follows:

1. Bring up the image's context menu on the document type navigation pane.

View r
@ Refresh <F5x
Z» Scan again
‘L":i Select from file
I _,‘? Rename <F2=
ﬂ Delete <Del=

2. Select the Delete menu item.
The selected image will then be deleted.
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3. Go to the document type navigation pane to the tab to be deleted.

; Passport | Driver license | Pension certificate

4. Click Delete document on the control panel.

Control panel

Document name

Pension cerdificate

|'i3 Add document

3

Delete document

| i Delete document from list

5. Confirm the deletion by clicking Yes.

Folder deletion confirmation |

Do you really want to delete the folder "Passport™ and all it's

content?

~ -

v |

The tab and all of the images in it will then be deleted.
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